











Who thinks about ...

... architecture while coding?

... architecture before coding”?



Who thinks about ...

.. security while coding?

... security before coding”



VWho wants to ...

... develop secure applications”
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OWASP TOP 10 2013

Injection

Broken Authentication and Session Management
Cross-Site Scripting (XSS)

Insecure Direct Object References

Security Misconfiguration

Sensitive Data Exposure

Missing Function Level Access Control
Cross-Site Request Forgery (CSRF)

Using Components with Known Vulnerabillities

Unvalidated Redirects and Forwards






OWASP Proactive Controls 2016

CO1 Verity for Security Early and Often

C02 Parameterize Queries

CO3 Encode Data

C04 Validate All Inputs

CO5 Implement ldentity and Authentication Controls
CO6 Implement Appropriate Access Controls

CO7 Protect Data

C08 Implement Logging and Intrusion Detection
CO09 Leverage Security Frameworks and Libraries

C10 Error and Exception Handling



Verity for Security Early and Often

Know the web application
Know all external entities
|[dentify all data flows

Identify all risks

CO1



Threat

Anything that threatens the application, its data
or any other asset



Common security flaws

-orget to authenticate a user
Broken authorization
No auditing functionality
Using components with known vulns



External
Entity

Process

Data
Store

Data
Flow

Data Flow Diagrams

People or code outside your control
Any running code
T'hings that store data

Communication between processes
Or processes and data stores

Web
Server

Browser

Database

http

https
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Trust Bounadaries

Trust  Where entities with different . Gereric

Trust

Boundary privileges interact ; Boundary ;

FomTTTTTTmmmmm ey Generic Trust Boundary

https Web https ','
i > \ Server | ¢ e https Web https
: : — > \ Server | '

Generic Trust Boundary:s
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Where are the threats?

Follow the data flow
Start with data crossing boundaries




STRIDE

poofing Pretending to be something or somebody else
Violated property: Authentication

ampering Modifying something on disk, network or memory
Violated property: Integrity

epudiation Claiming that someone didn’'t do something
Violated property: Non-Repudiation



nformation
Disclosure

enial of
Service

levation
of Privilege

STRIDE

Providing information to someone not authorized
Violated property: Confidentiality

Absorbing resources needed to provide service
Violated property: Availability

Doing something someone Is not authorized to do
Violated property: Authorization



Cloud
Denial of o Information
Service Repudiation Disclosure

(log file tampering) (dump database)

Tampering
(data manipulation)

Spoofing

(CSRF) Elevation of Privilege

(access backend
logic directly)
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Threat Modeling



Repudiating

L ogging all security relevant

actions ~09 actions in an audit log & 1001
Spoofing a dentification Password policy, token, password

O o and POIICY, P 1 1002

user . reset Process
authentication

Netwprk Clastic cloud Dynamic cloud 'esources (servgrs 3 1006

flooding and databases) to provide service
Tampering

network  Cryptography HTTPS/TLS 1 1007

packets



Fight the
identified
threats by
priority







S« Leverage Security
7 Frameworks and
 Libraries




Frameworks and
libraries decline
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The unfortunate reality of insecure libraries

o Up to 80% of code in today’s applications comes from libraries
and frameworks

o 113 million downloads analyzed for the 31 most popular Java
libraries and frameworks

o 26% had known vulnerabilities (29 million)

o Most vulnerabilities are undiscovered

Jetf Willlams & Arshan Dabirsiaghi
The Unfortunate Reality of Insecure Libraries
Aspect Security (March 2012)

http://cdn2.hubspot.net/hub/315719/file-198868966 1-pdf/download-files/The_Unfortunate_Reality_of_Insecure_Libraries.pdf




JavaSecurty = -bash — 120x36

Marvin:JavaSecurity dos$ dependency-check --project JavaSecurity --scan ./*xx/*.jar
[INFO] Checking for updates

[INFO] Download Started for NVD CVE - Modified

[INFO] Download Complete for NVD CVE - Modified (595 ms)
[INFO] Processing Started for NVD CVE - Modified

[INFO] Processing Complete for NVD CVE - Modified (1468 ms)
[INFO] Begin database maintenance.

[INFO] End database maintenance.

[INFO] Check for updates complete (15456 ms)

[INFO] Analysis Starting

[INFO] Creating the CPE Index

[INFO] CPE Index Created (2092 ms)

[INFO] Analysis Complete (63657 ms)

Marvin:JavaSecurity dos$



## preparation
mvn dependency:copy-dependencies

## single project
dependency-check --project SampleProject
--scan target/dependency

## multiple projects
dependency-check --project MultipleProjects
-—scan ./**/*_ jar



## preparation
mvn dependency:copy-dependencies

## single project
dependency-check --project SampleProject
--scan target/dependency

## multiple projects
dependency-check --project MultipleProjects
-—scan ./**/*_ jar



## preparation
mvn dependency:copy-dependencies

## single project
dependency-check --project SampleProject
--scan target/dependency

## multiple projects
dependency-check --project MultipleProjects
-—scan ./**/*_ jar



## preparation
mvn dependency:copy-dependencies

## single project
dependency-check --project SampleProject
--scan target/dependency

## multiple projects
dependency-check --project MultipleProjects
-—scan ./**/*,jar
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DEPENDENCY-CHECK

%

Oependency-Chetk 3 an open source 1o parforming & beal effior! aralysia of 3 party dependencen, faise poalives and falie fogelivens may exial in Pe sraysn performed by the ool Use of e ool and e reporting provided cormbitulen acceptance for use in an AS 1S condiion, and here are NO waranticn, mplad or chwrwise, with sopard 10 he analiysis or
s ute. Any useo of e 1ol and the reporing provided is ot 1he uter’s s In No event shal Be copyright holder o ONASE Lo held fabie for any damages whatsoever ariang oul of of i Cormedion with the wse of e 1ol the aralyss perfor=ed. or the resuling regort.

Project: MultipleProjects

Scan Information (show all):

« dependency-check version: 1.3.6
« Report Generated On: Mal 27, 2016 at 12:31:02 MESZ
+ Dependencies Scanned. 172

Dependency CPE GAV Highest Severity CVE Count CPE Confidence Evidence Count
jstl-1.2 jar cpe/a:apache:standard_taghts:1.2.1 javax.sendetjsi:1.2 High 1 LOW 18
commons-beanutils-1.8.3.jar cpe/aapache.commons_beanutils:1.8.3  commons-beanutils.commons-beanutils: 1.8.3 High 1 LOw 24
commons-beanutils-core-1.8.3jar  cpe/a:apache:commons_beanutils:1.8.3 High 1 LOW 21

xalan-2.7.0 jar cpe/a:apache:xalanjava:2.7.0 High 1 HIGHEST 28
Dependencies

jsti-1.2 jar

File Path: _ JavaSecurity/access-control-spring-securityftarget/dependencyijst-1.2 jar
MDS5: 51e15(798e69358cbB893e38c50596b9b

SHA1: 74aca283cd4f4baf3e425(5820cda58144409547

Evidence +




<reporting>
<plugins><plugin>
<groupld>org.owasp</groupIld>
<artifactId>dependency-check-maven</artifactId>
<version>1.3.6</version>
<reportSets>
<reportSet>
<reports>
<report>aggregate</report>
</reports>
</reportSet>
</reportSets>
</plugin></plugins>
</reporting>



Jenkins integration

o Dependency Check might take too long for an automatic
build after every push

o Extend only the nightly build job with Dependency
Check

o Don’t set up an individual NVD per job, use a
centralized one and update It separately



Create a NVD update only job

Bulid Triggers
Trigger builds remolely (e.g., from scripts)
Buid after other projects are built

Buid penodically

= Sweekly

Would last have run at Saturday, February 13, 2016 10:02:02 PM CET, would next run at Saturday, February 20, 20168 10:02:02 PM CET.
Buid when a change is pushed %o GitHub
Pol SCM

Builld Environment

Delete workspace belore buid starts
Send Nles or execute commands over SSH belore the build starts

Send fles or execute commands over SSH after the bulld runs
Instal custom Wols
Build

invoke OWASP Dependency-Check NVD update only

Data directory U , S

Enable verbose logging
Skp If tnggered by SCM changes
Skip If triggered by upstream changes

-~

=




Reference the database in every build

© Run only if build succeeds ~ ' Run only if build succeeds or is unstable ' Run regardiess of build result

ShoUla e POSIDUID SIODS un ONYy 10r SUCCeSSIU DUics, ofc

Post Steps

Invoke OWASP Dependency-Check analysis

Path 10 scan L2
Output directory O
Data directory
Users/dos/owasp-md L2
Suppression file )
ZIP axtensions )
Post-bulid Actions

Use Maven artifacts as scan path (deprecated)

Disable NVD auto-update Publish OWASP Dependency-Check analysis results
Enable verbose logging Dependency-Check results
Generate optional HTML reports Fiasol Inciudos sefting that spocies the generated raw Depondency-Check XML ropon Mos, such as " /dependoncy-check-teport xmil. Basedr of the 14050t IS 10 WOrksnacs ot if no valkuo s sot. 1hon the detaut "dopondency-chock-reportam is used. Be sure not 10 NCLOe any non-
POt 1068 110 I DA
Skip # triggered by SCM changes Run always
Skip # triggered by upsiream changes By OoauT, TS PG MuNs ONly 10r SIADIe OF LNSIADIe DUGS, BUT NOE 10r fRled DUGS. ¥ TS Plug<n SAOUD MUn even 10¢ 12803 DUlds THen ACTVENG IS CHOCK Box.
Detect modules
Oolermngs AN Of Naves MOOUE SHOU DO 00008 107 AN 1468 ! CONMAN wamings ACTVEDAQ TS ODEON MAY INCHESE YOU' DUR] 1M SNCE NG ONECIO! SCANE NG WO WOrRSDACH 1O Dot XMl OF POML XY 1ies 1 Or00! 10 2550 1N COMECE MO Aa ™Gl
Health threshokis
100% @B 0%
Configure the 1hreshoids 1or the buld heath. if loft ompty then NO health report s croated. I the actul number of Warmings 'S Detweon 1N Drovidod 1resholds then the bulid health s Nlerpoiated
Health priorities Only priority high” = Priorities high and normal) All priorities
Determines aMich waming priornses SHouid Do CoNSanrod Wwhen evaluaing e build hoain
Status thresholds (Totals) All priorities Priority high Pricrity normal Priority low
10 4 6
<

¥ 10 UMD Of 100N wiIngs (S 0roater 1NN 0% Of WSS IOENCKES 1NN & DUld & CONBIOEEd 35 UASIADIS O MA0d, MESPICIVEYy 9., & Wil Of O MEans IN1 T DU SAILS 1S ChANGOd I INDNE 1§ A1 DA 0% WarmIng 10Und. Leave I 1id empty 11 5800 Of I DUl SNould fOt 00pend
ON Me NuMZer of Wamngs

Compute new warnings (based on the last successiul build unless another rederence build is chosen below)
Default Encoding

Dotaut encodng when parsing of showing Nes. Loave this foid ompty 10 uso the default oncodng of the platiorm

Trend graph Y n define { fault v s for the trend graph in a separate view.



Dependency-Check Result
Warnings Trend

All Warnings

4

Summary

Total High Priority
4 2
Details

CWEs CVEs Wamings Details New Fixed

New Warnings

High  Medium

Normal Priority

ld

Low

Total Distribution

Fixed Warnings

Low Priority

count

~
O
—
RS

Dependency-Check Trend

#168

#£169

#170
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® o
Q

» Appearance & Behavior
Keymap
» Editor
Plugins
» Version Control
» Build, Execution, Deployment
» Languages & Frameworks
» Tools
v Other Settings
Checkstyle
HOCON
SonarLint General Settings
Sonarlint Project Settings

Preferences

Other Settings > FindBugs-IDEA  For current project
2K b §

- Report Filter Detector

Compile affected files before analyze
Analyze affected files after compile
Analyze affected files after auto make
Run analyze in background

Activate toolwindow on run

Plugins
+ -

Find Security Bugs (com.h3xstream findsecbugs)
Find Security Bugs is a plugin that aims to help security audit.
https://github.com/h3xstream/find-sec~-bugs

Annotate Share

® o Preferences
Q Other Settings > FindBugs~-IDEA  For current project
~ Appearance & Behavior @ &
Keymap
» Editor Ceneral  Report  Filter _ Annotate  Share
Plugins 0 Disabled detectors will not participate in the analysis.
~ Version Control ‘Crayed out’ detector will run, however they will not report any result to the Ul.
+ Build, Execution, Deployment Q- Y I =  Providerv
» Languages & Frameworks v Provider g4 Description
ERRun v _Find Security gs ' Identify Bad hexadecimal concatenation
© Other Settings
BroadcastDetector
Checkstyle Plugi Fi i
: o CipherWithNolntegrityDetector — Ty
FindBugs-IDEA © CommandinjectionDetector Plugin Id com.h3xstream.findsecbugs
HOCON ConstantPasswordDetector Detector Name |BadHexadecimalConversionDetector
SonarLint General Settings CookieReadDetector

SonarLint Project Settings © CrifLoginjectionDetector

Reported patterns:

CustominjectionDetector
CustomMessageDigestDetector
DesUsageDetector
EsapiEncryptorDetector

Bad

SECURITY |SECBHC |BAD_HEXA_CONVERSION |hexadecimal

concatenation

ExternalConfigurationControlDetector
ExternalFileAccessDetector
FileUploadFilenameDetector
CeolocationDetector
CoogleApiKeyDetector
HazelcastSymmetricEncryptionDetector

HttpResponseSplittingDetector
Incsecure nnkisNetertnr

SO000000000000000ee

cocel Aoy | (D



l csrff.../OrderServiet.java - nvasecurny ("/Dmlopmenulntellw.lavaSecurnyl

--.-'- '..----l-.. A TR e e - e .-' --——

8 [ Project v © | B I~ LOGGER. error (ex.getMessage(), ex);
i e  [iJavaSecurity [javasecurity] ~/Devel }
| » O.idea LOGGER. info("Order servlet: CSRF token is valid");
» [jaccess~-control-spring-security
» [icrypto-hash String product = request.getParameter(“product”); > 2
é » Cacrypto-java int quantity = Integer.parselnt(request.getParameter(“quantity”));
2~ Licrypto-keyczar fu LOGGER. info("Ordered {} items of product {}", gquantity, product); -
‘3 » [Jcrypto-shiro
; » [icrypto-spring response.setContentType(“text/htal"”);
> Licsrf try (PrintWriter out = response.getwWriter()) {
» [Jcsrf-spring-security out.printin(“<html>");
» [Cidirect-object-references out.printin(“<head>");
» [jintercept-me out.println("<link rel=\"stylesheet\" type=\"text/css\" href=\"resources/css/styles.css\" />");
out.println(“<title>Cross-Site Reguest Forgery (CSRF): Order Confirmation</title>");
» Cisecurity-header out.printin(“</head>"); -
» [Jsession-handling out.printin(“<body>");
» [isession-handling-spring-secu out.printin("<hl>Cross-Site Request Forgery (CSRF): Order Confirmation</hl>");
» [asql-injection e out.printin(“<p><strong>Ordered " + quantity + " of product " + product + "</strong></p>");
out.printin(“<p><a href=\"index. jsp\">Home</a></p>");
» Cixss out.printin(“</body>");
€ .gitignore out.printin("</html>");
i travis.yml } catch (IOException ex) {
B findbugs-security-exclude.am! : LOGGER.error(ex.getMessage(), ex);
P o findhune . caruritv.include vml )
$ FindBugs-IDEA 8- i
e oL GRLF e uIn 10r 1oygs L0 erns)
v [1 Cross site scripting vulnerability (9 ite PreviewOrderServietjava:
s * & X O P Sorvt mﬂme: : Wﬂ s S e e HTTP parameter written to Serviet output
t P @ & X 5 e Mo out.printin(“<title>Cross-Site Request
2 & HTTP parameter written to Serviet g4 out.println{“</head>"): Class:
o B & Q # HTTP parameter written to Serviet 89 out.printin{“<body>"); OrderServiet (de.dominikschadow.javasecurity.csr
P 2 & 3 © HTTP parameter written to Servlet °° out.println(“<hl>Cross-Site Request Fo.
% k3 91 % out.printin(“<p><strong>Ordered " + QUi  Method:
B x © HTTP parameter written to Serviet g3 out.printin{“<p><a href=\"index.jsp\ "> _::.;,:L
e . £ HTTP parameter written to Serviet :3 ovtoorint{t':"/:cdr“;:
@ Kl out.printin(“</html>"); . .
g * ¥ @ HITF pasameter written to Seivieq) | oo } catch (IOException ex) { Serviet reflected cross site scripting
S i € HTTP parameter written to Serviet g6 LOGGER.error(ex.getMessage(), ex); vulnerability
& HTTP parameter written to Serviet 97 } This code directly writes an HTTP parameter to Servl
& © HTTP parameter written to Serviet :: ) } outnut. which allows for a reflected crocs <ite <crintin

() Docker (3 Java Enterprise W, 9:Version Control @) Spring  ¢$ CheckStyle [@ Terminal ( SonarLint [N 0: Messages ¥y Event Log

Pling Uy &

12004 uaney 3

aseqereq 1]
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Demo

FindSecurityBugs



Beyond the top 10
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Defense In depth




Security response headers

X-Frame-Options
Content Security Policy (CSP)
HTTP Strict Transport Security (HSTS)
HT TP Public Key Pinning (HPKP)



Individual Servlet filter for every header

o Intercepts all responses
o Always identical configuration
o Easier to test
o A single place to configure each policy

o Easier to integrate in other web applications (ok: copy)



@WebFilter (filterName "CacheControlFilter", urlPatterns = {"/*"})
public class CacheControlFilter implements Filter {
public void doFilter(ServletRequest sReq, ServletResponse sRes,
FilterChain fc) {
HttpServletResponse response = (HttpServletResponse) sRes;
response.addHeader ( "Cache-Control”,
"no-cache, must-revalidate, max-age=0, no-store'");
fc.doFilter(servletRequest, response);

}

public void init(FilterConfig filterConfig){}

public void destroy() {}
}



@WebFilter (filterName "CacheControlFilter", urlPatterns = {"/*"})
public class CacheControlFilter implements Filter {
public void doFilter(ServletRequest sReq, ServletResponse sRes,
FilterChain fc) {
HttpServletResponse response = (HttpServletResponse) sRes;
response.addHeader ( "Cache-Control”,
"no-cache, must-revalidate, max-age=0, no-store'");
fc.doFilter(servletRequest, response);

'

public void 1nit(FilterConfig filterConfig){}

public void destroy() {}
}



@WebFilter(filterName = "CacheControlFilter", urlPatterns = {"/*"})
public class CacheControlFilter implements Filter {
public void doFilter(ServletRequest sReq, ServletResponse sRes,
FilterChain fc) {
HttpServletResponse response = (HttpServletResponse) sRes;
response.addHeader ( "Cache-Control"”,
"no-cache, must-revalidate, max-age=0, no-store");
fc.doFilter(servletRequest, response);

'

public void 1nit(FilterConfig filterConfig){}

public void destroy() {}
}



response.addHeader (
"Policy name',
"Policy value’

) ;



Additional
security




X-Frame-Options

Prevents Ul redressing attacks



Ul redressing attacks in a nutshell

e 00 Login Form | e
> 4 g
€ C B ® ff <&~ » =
Username
Password
Send
2 -
e O Fake Login Form - > =
J N
€ ~ B ® M e » =

Send

i frame

> |

Username

Password

B ® ft -




response.addHeader (
"X-Frame-Options ,
"DENY"

) ;

"SAME-ORIGIN"
"ALLOW-FROM [uri]”



X-Frame-Options browser compatibility

€ € 0
@ @

ALLOW-FROM only supported
INn Firefox and Internet Explorer




Content Security Policy (CSP)

Whitelist all content
Prevents content injection
(Cross-Site Scripting)



response.addHeader (
"Content-Security-Policy",
"default-src 'self'”

) ;



Content Security Policy Directives

default-src default if specific directive is not set
object-src Sources in object, embed or applet tags
script-src Script sources (includes XSLT)

CONNECt-Ssrc XMLHttpRequest, WebSocket, ...

font-src Font sources

child-src Sources embeddable as frames/ iframes
IMQg-Src lmage sources

media-src Video and audio sources

style-src CSS sources (does not include XSLT)

www.w3.0org/TR/CSP2


http://www.w3.org/TR/CSP2

response.addHeader (
"Content-Security-Policy",
"default-src 'none’;
script-src 'self';
lmage-src 'self';
font-src 'self' https://fonts.googleapis.com;
style-src 'self' https://fonts.googleapis.com”



{ Violation Report

"document-uri":"http://.../reporting. jsp?
name=%3Cscript%3Ealert(%$27XSS%27)%3C/script%3E",

"referrer":"http://www.sample.com/security-header/
index.jsp',

"blocked-uri":"self",

"violated-directive":"default-src http://www.sample.com",

"source-file":"http://.../reporting. jsp?
name=%3Cscript%3Ealert(%$27XSS%27)%3C/script%3E",

"script-sample":"alert('XSS')",

"line-number":10



CSP Level 1 browser compatibility

Android Chrome for
Browser Android

IE Edge Firefox Chrome Safari Opera I0S Safari Opera Mini

4

4.3

4.4
4.4.4

46
A

0.2

34 47

9

5

http://caniuse.com/#feat=contentsecuritypolicy




Adding CSP to your application

o Don’t use inline styles or scripts

o Start with default-src: 'none'
(or default-src: 'self')

o Configure other directives to make your application work
o Specify a report URI and improve the CSP header

o Use a generator, browser developer tools and an analyzer



One header to rule them all
o CSP Level 2 will replace other headers in the future

o Be aware that older browsers understand the current
(old) headers but will never understand CSP Level 2



Content Security Policy 2 extensions

frame-ancestors

Allow resource frame embedding (obsoletes X-Frame-Options
header)

reflected-xss

(De-)activate user agent XSS heuristics (obsoletes X-XSS-
Protection header)

upgrade-insecure-request

Load everything over HTTPS, even if URL specifies HTTP (page is
loaded via HTTPS)

block-all-mixed-content

Prevent browser from loading any assets using HT TP when using
HTTPS



response.addHeader (
"Content-Security-Policy",
"default-src 'self’;
frame-ancestors none' °



Upgrade requests to HTTPS

o Forces browsers to upgrade any link automatically to
HTTPS

o Does not block the request, but upgrades it

o Implemented as CSP directive or meta tag



<meta http-equiv="Content-
Security-Policy’ content="upgrade-
lnsecure-requests ">



CSP Level 2 browser compatibility

IE Edge Firefox Chrome Safari Opera IOS Safari Opera Mini  Android Browser Crmé?gi(fjor

A

5

¢ K 3

http://caniuse.com/#feat=contentsecuritypolicy?2



®0® <

€f'd REPORT LR

Home > Tools > CSP Builder

Here is your Policy!

» report.uriio

Home

Tools FAQ

Content-Security-Policy: default-src ‘none’ ; script-src 'self’ ; style-src "self’ ; img-src 'self' ; font-src "self’ ; frame-ancestors 'none’ ; form-action 'self' ; upgrade-insecure-
requests; block-all-mixed-content; reflected-xss block;

Import a policy

of Build your CSP

1) Default Source ¥

2) Script Source
3) Style Source &
4) Image Source &
5) Font Source &
6) Connect Source
7) Media Source

8) Object Source
QY Child Sniirece

Default Source View Info

None
All

Self

Data

Unsafe Inline
Unsafe Eval

g o NN Y o \ | w4
a8 SePd ated st Of hosis

Content-Security-Policy

Ch

e



HT TP Strict Transport Security (HSTS)

Force HTTPS
Prevent TLS stripping



Without HSTS, first call

HTTP
301 HTTPS
HTTPS

e ————

Server is issuing a 301 redirect



Without HSTS, second call

HTTP
301 HTTPS
HTTPS

e ————

Server is issuing a 301 redirect



response.addHeader (
"Strict-Transport-Security’,

‘'max-age=31556926"

"max-age=31556926; 1includeSubDomains"”

"max-age=31556926; 1includeSubDomains; preload’



With HSTS, first call

HTTP
301 HTTPS (+ HSTS)

HTTPS

e ————

Server is issuing a 301 redirect



With HSTS, second call

307 HTTPS

Browser is issuing a 307 internal redirect



HSTS requirements

o The configured duration should not expire, there will be an
Initial unprotected request otherwise

o All resources must be available via HTTPS, includes any
(external) scripts, images, ...

o Valid certificate required, no self-signed certificates any
more

o Requires a HTTPS connection, not active on HTTP
connections



HSTS preload list

o Preload list for HSTS hosts hard coded into Chrome
o Included in Firefox, Internet Explorer and Safari

o Requires the complete HSTS header
Strict-Transport-Security "max-age=31556926;
includeSubDomains; preload”

o Submit your page at https://hstspreload.appspot.com


https://hstspreload.appspot.com

HSTS browser compatibility

Android Chrome for

Firefox Chrome Safari Opera i0S Safari Opera Mini Browser Android

4
46
4

4.3

4.4

9 34

9.2
|93

http://caniuse.com/#feat=stricttransportsecurity




HTTP Public Key Pinning (HPKP)

Fixes the broken CA system
Be careful, invalid hash
porevents page access



response.addHeader (
"Public-Key-Pins ,
"pin-sha256="'eSC+HMO..wuKgUzrd=";
pin-sha256="7HIpact..oQYcRhJ3Y=";
max-age=5184000;
includeSubdomains:
report-uri='https://..."'");

) ;
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86 < > M noly " report-urlio

& infolreport-urio ’ cos 10 [ Regscer
€f7d REPORT LRI N

Home > Tools > HPKP Hash Generater

Create your HPKP hash
hitps /iwew.google. de -

Here is your PKP hash for www.google.de: pin-sha256~"eSC+HMYOEATZRNZrIRIGULAQXTIgTOVXoNBwuKgUzré="
Here is your PKP hash for Google Internet Authority G2: pin-sha256~"7THIpactklAQ2Y490rFOOQKuUrWxmmSFZhBCoQYcRh)3Y~"
Here Is your PKP hash for GeoTrust Global CA: pin-sha256="h6801m+z8v3zbgkRHpq6L29Esgfzh|89C1SyUCOQmqU="

Here is your PKP hash for Equifax Secure Certificate Authority: pin-sha256+"/1aAzX0IcD2g5Begdf1G)QanNQbEUBOVE+IUIHSTHY ="

About Contact Tweet
report-uriio is a project created by Scolt Helme Email; info@report-uriio Send us a tweet Crepontur




APKP prowser compatipility

Android Chrome for
Browser Android

|E Edge Firefox Chrome Safari Opera IOS Safari Opera Mini

4

9.2 47

9 34

I

http://caniuse.com/#feat=publickeypinning




_in the current response-
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securityheaders.io Home  About

Scan your site now

https://www.google.de/ Scan

B de resuits

r -

‘ Security Report Summary

Site: httpa hoaw . Soodie. Oe/
I? Address: 2607 18004005 3032003
Report Time: 13 Feb 2016 16:01:56 UTC
Meaders:
Raw Headers
NTT?/1 200 OK
Date SOL 13 e 2016 16201 SEOGMT
Expires d
Cache-Control private, mac-age-0
Contert Type teat/ W, Charset=UTF8
PP CPe"This is not a PP policy! See https/'www googie com/support/accounts/answer /1516577 hisen for more Info.*
Server Qs
X-X$5-Protection 1 modesbiock
X-Framme-Opticns SAMEORIGIN
Set-Cookie CONSENTVWP 250320; expires«Fri, 01 4an-2038 000000 GMT; pathe [, domaine googie.oe
Alternate-Protecel MMl guic o
At-Swe QU= "WWW. 0000 ¢ COMLEL3", ma«1532000; v="30.29 28 27,26 25" Qu=" 443", ma=2532000; v="30 23 2827 26.25"
Accept-Ranges rone
Vary Accept-Enceding
Tramafer-Encoding chunked

~ Missing Headers



Analysis results for:

hitps.//blog.dominikschadow.de/

- -
F R Click the icons in the tables below for a more detailed explanation.
A B 4

HTTP security headers

x-frame-options deny
cache-control -cache, must-revalidate
no-cache, mu evalidate

content-security-policy

strict-transport-security max-age=31556926

1: mode=Dblock

X-XSs-protection

access-control-allow-orgin Header not returned

default-src "self’; img-src *; font
'self’ hitps.//fonts.googlea

e, max-age=0, no-store,

-SrC °; style-src

pis.com 'unsafe-iniine’;

Page, Header & Cookie Security

Analyser

4 <

S N S

Recx is a HT TP header and
cookie security analyzer
plugin for Google Chrome

Alternatives are the Security
Headers extensions for
Chrome and Firefox



Demo

security-header



summary

Use the OWASP Proactive Controls
as a real world guide

Start small and secure your
development part first

Spread the word
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